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[bookmark: _Toc451855783]摘要
由此處開始寫中文摘要（請注意行首要縮排）。茩妏蚚閉湮講捇誥蚘眊，假蚾佽隴妏蚚揤坫婦囀假蚾蚔牁，秪蚔牁峈楛极笢恅唳，潠极炵苀珆尨頗堤珋觴鎢，珋衄謗笱源楊賤樵，諷秶醱啣。郖睿逄晟恁砐，詢撰笢腔笢恅笢弊，蜊峈笢恅怢俜，綴偌茼蚚，睿隅笭數呾儂婬堍俴蚔牁撈褫，妏蚚揤坫婦囀觓湍腔趙楛峈潠馱撿，妏蚚源楊，湖羲趙楛峈潠，輛蚔牁。遙堤懂，趙楛峈潠奻腔雄怓境諉，恁寁婓等僻趙楛峈潠，遙隙蚔牁藩棒輛蚔牁笭葩眕奻雄釬。
第二段（請注意行首要縮排）。茩妏蚚閉湮講捇誥蚘眊，假蚾佽隴妏蚚揤坫婦囀假蚾蚔牁，秪蚔牁峈楛极笢恅唳，潠极炵苀珆尨頗堤珋觴鎢，珋衄謗笱源楊賤樵，諷秶醱啣。郖睿逄晟恁砐，詢撰笢腔笢恅笢弊，蜊峈笢恅怢俜，綴偌茼蚚，睿隅笭數呾儂婬堍俴蚔牁撈褫，妏蚚揤坫婦囀觓湍腔趙楛峈潠馱撿，妏蚚源楊，湖羲趙楛峈潠，輛蚔牁。遙堤懂，趙楛峈潠奻腔雄怓境諉，恁寁婓等僻趙楛峈潠，遙隙蚔牁藩棒輛蚔牁笭葩眕奻雄釬。
關鍵字：最多五個，標楷體，12點字，用逗號，分隔。
[bookmark: _Toc451855784]Thesis/Dissertation Title
Author’s Name
Advisor’s Name
Department & College
	SUMMARY
The summary is a short, informative abstract of no more than 250 words. References should not be cited. The summary should (1) state the scope and objectives of the research, (2) describe the methods used, (3) summarize the results, and (4) state the principal conclusions. Text of the summary should be 12 pt Times New Roman font, 1.5 line space and justified. A 1.5 line space should be left below the title ‘SUMMARY’. Leave a single line space above the key words listed below. 
Key words: Maximum 5 key words in 12 pt Times New Roman, separated by commas. 


INTRODUCTION
The purpose of the introduction is to tell readers why they should want to read your thesis/ dissertation. This section should provide sufficient background information to allow readers to understand and evaluate the paper’s results. The introduction should (1) present the nature and scope of the problem, (2) review related literature, (3) describe the materials used and method(s) of the study, and (4) describe the main results of the study.
All text in the main body of the extended abstract should be 12 pt Times New Roman font, 1.5 line space and justified. Main headings are placed in the centre of the column, in capital letters using 12 pt Times New Roman Bold font. Subheadings are placed on the left margin of the column and are typed in 12 pt Times New Roman Bold font.
MATERIALS AND METHODS
There is flexibility as to the naming of the section (or sections) that provide information on the method(s) or theories employed. The methodology employed in the work must be described in sufficient detail or with sufficient references so that the results could be duplicated.
Your materials should be organised carefully. Include all the data necessary to support your conclusions, but exclude redundant or unnecessary data.
RESULTS AND DISCUSSION
The results and discussion sections present your research findings and your analysis of those findings. The results of experiments can be presented as tables or figures.
Figures and Tables
Figures may be integrated within the results section of the extended abstract, or they can be appended to the end of the written text. Figures should be black & white. They should be no wider than the width of the A4 page.
Tables can be created within Word. As noted for figures above, if a table is to be placed within the text, it can be no wider than the width of the A4 page. Larger tables will need to be placed at the end of the abstract.
Figures and tables should be numbered according to the order they are referenced in the paper. Figures and tables should be referred to by their number in the text. When referring to figures and tables in the text, spell out and capitalize the word Figure or Table. All figures and tables must have captions.
Captions
Captions should clearly explain the significance of the figure or table without reference to the text. Details in captions should not be restated in the text. Parameters in figure captions should be included and presented in words rather than symbols.
 Captions should be placed directly above the relevant table and beneath the relevant figure. The caption should be typed in 12 pt Times New Roman Bold font. Spell out the word 'Table' or ‘Figure’ in full. An example table and a figure follow.
Table 1. Specifications of the engine
	Engine
	OPEL Astra C16SE

	Displacement (cc)
	1598

	Bore x stroke (mm x mm)
	79 x 81.5

	Valve mechanism
	SOHC

	Number of valves
	Intake 4, exhaust 4

	Compression ratio
	9.8:1

	Torque
	135/3400 Nm/rpm

	Power
	75/5800 kW/rpm

	Ignition sequence
	1-3-4-2

	Spark plug
	BPR6ES

	Fuel
	95 unleaded gasoline

	Cylinder arrangement
	In-line 4 cylinders
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  Figure 1. HC emission as a function of equivalence ratio
CONCLUSION
This section should include (1) the main points of your paper and why they are significant, (2) any exceptions to, problems with, or limitations to your argument, (3) agreements or disagreements with previously published work, (4) theoretical and practical implications of the work, and (5) conclusions drawn.
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[bookmark: _Toc451855790]緒論
這是論文的第一章，通常它的標題是「緒論」，不過，你也可以使用其他任何你覺得更適合你論文現況的標題。
[bookmark: _Toc98324476][bookmark: _Toc451855791]如何使用這份樣版 [第一層的副標題]
這個論文的中文樣版，是以滿足成功大學工業設計學系之學位論文格式要求為目的而設計的。我們基本上遵循APA的格式規定，但還是有稍作調整。其注意事項包含：邊界的設定要正確；目錄中的格式要正確；必要的內容依正確的順序來寫作；頁碼會出現在正確的地方並符合正確的形式；字型和大小也符合規範。 
根據成大圖書館的要求，你的論文應該印在80gsm 的白色A4紙上。封面頁的邊界，上：2.3公分；下：3公分；左右各2公分。封面頁中文標題之字型為標楷體，16點，居中對齊。封面頁英文標題之字型為 Times New Roman，14點，文字置中。作者及指導教授的名字要有中文及英文。中文字為標楷體，14點，粗體字，英文為 Times New Roman，14點粗體字。所有封面頁上的文字應置中對齊。
內頁的邊界，上：2.3公分；下：3.5公分；左3公分；右2.5公分。本文字型為新細明體，12點字，文字左右對齊。與前段間距為0行，與後段間距為6點。行距為1.5倍行高。第一行縮排2字元。
[bookmark: _Toc451855792]請以你自己的文字取代這份樣版的文字[這是第二層的副標題]
很明顯的，你需要用你自己的文字取代這份樣版的文字。要刪除樣版裡的文字，最簡單的方法是把游標移到第一段的前面並點擊滑鼠左鍵，之後向下滾動到章節的最後一行，把游標移到最後一個句號後，按住SHIFT鍵不放並點擊滑鼠左鍵，像這樣，兩個點擊之間的一切文字都會被選取。
當你選取了所有的文字之後，只要按DELETE鍵，即可刪掉所有的文字。然後，你可以在這個章節中，開始輸入你的文字。
[bookmark: _Toc451855793]編輯時的注意事項
注意不要弄亂這份樣版的設定。例如，當你刪除文字的時候，請注意不要刪到任何「分隔設定」，如果你不小心刪了分節符號，頁碼會整個亂掉。
1.1.1.1   正確地使用 Tabs [這是第三層的副標題]
如果你想要自己打目錄，你必需注意頁碼的對齊。標題與頁碼間，請不要用空白鍵來對齊，應該用Tab鍵來對齊。因為Tab鍵的定位點是固定的，所以當你的章節標題很短的時候，需要多按幾下來正確的對齊。
但最好的其實是利用本樣版所定義好的標題樣式之層級，電腦會自動幫你產生符合格式規定的目錄。
1.1.1.2   使用樣式來編輯論文
所有規定的文字格式，都已在這份樣版的「樣式」中設定好了。每一章的標題，例如：第 3 章  研究方法，應該使用「標題1」的樣式，其字型為標楷體，14點，粗體，文字置中，與後段間距為3.5行。第二層級的小節標題，例如：3.1 受測者資料，應使用「標題2」之樣式，其字型為新細明體，12點，粗體，靠左對齊，與前段間距為3.5行，與後段間距為6點。第三層級的小節標題，例如：3.1.1 大學部學生，應使用「標題3」之樣式，其字型為新細明體，12點，粗斜體，靠左對齊，與前段間距為2行，與後段間距為6點。第四層級的小節標題，例如：3.1.1.1 受測者性別，應使用「標題4 」之樣式，字型為新細明體，12點，加底線，不加粗，靠左對齊，且第一行縮排2字元。與前段間距為1.5行，與後段間距為6點。最後，內文應使用「本文」樣式（不是「內文」樣式），其字型為新細明體，12點字，文字左右對齊，與前段間距為0行，與後段間距為6點，行距為1.5倍行高，且第一行要有縮排2字元。
[bookmark: _Toc451855794]設定新的一章
如何開始使用這個樣版來設定新的一章，才能自動正確地編頁碼？下面是開始寫新的一章的步驟。
[bookmark: _Toc451855795]進入新的一章
新的一章應該要換頁，由下一頁的最上面開始寫下來，這時候請不要用Enter鍵來把文字擠到下一頁！你只需要在前一章的最後一段，打上你的章節標題，如「文獻探討」，把游標停在這行，然後把樣式改為「標題1」，如此，在標題段落之前會自動插入換頁碼，同時也會產生如「第2章」的自動標號。
[bookmark: _Toc451855796]文獻探討
Again, this template basically follow the APA style but with minor adjustments. Thus, your citations and references should be formatted in APA style. To do so, I strongly recommend you use Endnote, a commercial reference management software package, used to manage bibliographies and references when writing essays and articles. Endnote can be downloaded from NCKU library website for free. Thesis writing will be much easier if you managing bibliographies, citations and references with Endnote. 
0. [bookmark: _Toc451855797]文獻的Citation Style in APA format
[bookmark: _GoBack]This paragraph illustrates two common ways of citing references within the text using APA style. According to Smith (2001), two of the most important issues in education today are curriculum and instruction. In fact, both curriculum and instruction are foundational to the educational enterprise (Jones, 2003). Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat.
In APA, when citing two authors outside parentheses use “and” but inside parentheses use “&”. For example, Smith and Jones (2004) have described various perspectives of curriculum and instruction. Another way to write it is that curriculum has been defined as “an integrated course of academic studies” (Jones & Smith, 2005, p. 14). Please notice here that when quoting in APA format, include the page number. An alternate way to cite a page number when quoting in APA format is show in the following sentence. Jones and Smith (2005) refer to instruction as “the activities of educating or instructing or teaching” (p. 15).
Other types of reference resources please check APA style's official website (http://www.apastyle.org) for more instructions.
[bookmark: _Toc451855798]參考文獻
The followings are some frequently used reference resources. However, this is not a complete list. If you have any question, please check with the APA style manual (Figure 2.1).

[image: Macintosh HD:Users:hoch:Desktop:4200066-150_tcm11-76745.gif]
[bookmark: _Ref231034247][bookmark: _Toc357437605]圖2.1  The Cover of Publication Manual of the American Psychological Association (6th edition)
[bookmark: _Toc451855799]期刊的基本標註法
Author, A. A., Author, B. B., & Author, C. C. (Year). Title of article. Title of Periodical, volume number(issue number), pages. doi:http://dx.doi.org/xx.xxx/yyyyy 
[bookmark: _Toc451855800]書本的基本標註法
Author, A. A. (Year of publication). Title of work: Capital letter also for subtitle. Location: Publisher.
[bookmark: _Toc451855801]Article or Chapter in an Edited Book
Author, A. A., & Author, B. B. (Year of publication). Title of chapter. In A.A. Editor & B.B. Editor (Eds.), Title of book (pages of chapter). Location: Publisher.
[bookmark: _Toc451855802]線上期刊的文章
Author, A. A., & Author, B. B. (Date of publication). Title of article. Title of Online Periodical, volume number(issue number if available). Retrieved from  http://www.someaddress.com/full/url/
[bookmark: _Toc451855803]有DOI的線上期刊文章
Author, A. A., & Author, B. B. (Date of publication). Title of article. Title of Journal, volume number, page range. doi:0000000/000000000000 or http://dx.doi.org/10.0000/0000
[bookmark: _Toc451855804]由資料庫取得的文章
Author, A. A., & Author, B. B. (Date of publication). Title of article. Title of Journal, volume number, page range. Retrieved from http://www.someaddress.com/full/url/
[bookmark: _Toc451855805]報紙的文章
Author, A. A. (Year, Month Day). Title of article. Title of Newspaper. Retrieved from  http://www.someaddress.com/full/url/
[bookmark: _Toc451855806]Chapter/Section of a Web Document or Online Book Chapter
Author, A. A., & Author, B. B. (Date of publication). Title of article. In Title of book or larger document (chapter or section number). Retrieved from http://www.someaddress.com/full/url/
[bookmark: _Toc451855807]Nonperiodical Web Document, Web Page, or Report
Author, A. A., & Author, B. B. (Date of publication). Title of document. Retrieved from http://Web address
[bookmark: _Toc451855808]This is not a Complete List for References
Online Resources from the APA: http://www.apastyle.org; http://blog.apastyle.org/apastyle/
[bookmark: _Toc451855809]Citing Translated Sources in APA Style
Piaget, J. (1969). The psychology of the child (H. Weaver, Trans.). New York, NY: Basic Books.
[bookmark: _Toc451855810]Citing Chinese Sources in APA Style
中文文獻（需加註英譯）應置於英文文獻之前。中文文獻應依作者姓氏筆劃順序排列、英文文獻則依作者姓氏字母順序排列（若作者姓氏、字母相同時，則依序比較後列之字元）。於內文引用之寫法為「（作者中文姓名，西元出版年）」。此部分規定參考http://www.tana.org.tw/download/APA%20第6版範例下載.doc。
[bookmark: _Toc451855811]定期刊物
作者姓名（姓在先）（西元出版年）. 標題. 期刊名稱，卷（期），起訖頁數。
蔡淑鳳（2011）. 護理專業發展之機會與挑戰－臺灣護理精彩一百. 護理雜誌，58（3），5-11 。[Tsay, S. F. (2011). The opportunities and challenges of nursing professional development: Celebrating 100 years of nursing in Taiwan. The Journal of Nursing, 58(3), 5-11.]
[bookmark: _Toc451855812]一本書、書的一章、翻譯書
作者姓名（西元出版年）. 書名. 出版地：出版商。
陳美燕, 黃世惠, 張淑紅, 簡欣怡, 阮玉梅, 張彩秀…萬國華等 （2011）. 公共衛生護理學 （再版）. 台北市：啟英文化。 [Chen, M. Y., Huang, S. H., Chang, S. H., Jian, X. Y., Ruan, Y. M., Chang, T. H., … Wan, G. H. (2011). Public health nursing (2nd ed.). Taipei City, Taiwan, ROC: Ching Culture.]
林元淑、黃靜微（2008）. 新生兒及其護理. 於陳月枝總校閱，實用兒科護理 （五版，38-112 頁）. 台北市：華杏。 [Lin, Y. S., & Huang, C. W. (2008). Nursing care of newborns. In Y. C. Chen (Ed.), Practical pediatric nursing (5th ed., pp. 38-112). Taipei City, Taiwan, ROC:  Farseeing.]
American Psychological Association. (2011) . 美國心理學會出版手冊：論文寫作格式六版（陳玉玲、王明傑譯）. 台北市：雙葉書廊。（原著出版於2010）[American Psychological  Association. (2011). Publishing manual of the American Psychological Association, 6th ed. ( Y. L. Chen & M. C. Wang, Trans.). Taipei City, Taiwan, ROC: Yeh Yeh Book Gallery.   (Original work published 2010)]
[bookmark: _Toc451855813]政府部門、機構、其他組織的網路資料
作者姓名（西元年，月日）. 題目名稱. 取得網址。
疾病管制局（2011）. 98 傳染病統計暨監視年報. 取自http://www.cdc.gov.tw/public/Data/ 111911421871.pdf [Centers for Disease Control, Taiwan, ROC. (2011). 2009 annual statistical report: Infectious diseases and surveillance. Retrieved from http://www.cdc.gov.tw/public/ Data/111911421871.pdf]
[bookmark: _Toc451855814]碩、博士論文
作者姓名（西元年）. 論文名稱（未發表的博/碩士論文）. 城市：學校系所。
林麗梅（2010）．加護病房胃酸抑制藥物使用與發生院內感染型肺炎危險之相關性探討（未發表的碩士論文）．臺北醫學大學藥學研究所。[Lin, L. M. (2010). The use of acid-suppressive medications and the risk for hospital-acquired pneumonia in intensive care units (Unpublished master’s thesis). Taipei Medical University, Taiwan, ROC.]
[bookmark: _Toc451855815]未出版的論文發表、海報發表及研習會之文章
作者（西元年，月）. 題目. 論文/海報發表於主辦單位名稱之研習會名稱. 城市、國家：主辦地點。
張聿仁, 江琳盈 & 白玉珠（2011，9 月）. 耳穴按壓改善護理人員睡眠品質之效益分析. 海報發表於台灣護理學會主辦之第二十七次護理研究論文發表會暨兩岸護理學術交流. 台北市：國立臺北護理健康大學。[Chang, Y. J., Chiang, L. Y., & Pan, Y. C. (2011, September). Effectiveness of auricular acupressure on insomnia in nurses. Poster session presented at the 27th Annual Nursing Research Conference of the Taiwan Nurses Association, Taipei City, Taiwan, ROC.]
[bookmark: _Toc451855816]研究計畫
作者姓名（含計劃主持人及研究人員）（西元年）. 計畫題目名稱（計畫所屬單位及編號）. 城市：出版或製作此報告的單位。
黃璉華（2010）．護理正向執業環境的探討與改善效果（研究計劃編號TWNA-0991002）．台北市：台灣護理學會。[Huang, L. H. (2010). The effects of improving positive practice environments on nurses in a medical center (Research Grant TWNA-0991002). Taipei City, Taiwan, ROC: Taiwan Nursing Association.]
[bookmark: _Toc451855817]Citing Translated Sources in APA Style
If you are citing a source, such as interview or text, in another language, and you paraphrase into English, or translate a quotation into English and include it as part of your paper, it's not necessary to note that you did the translation at every cite since everything not attributed to another is assumed to be the work of the author. However, many authors state this in a footnote or parenthetical comment at the first translation (e.g., "all translations from Chinese are my own").
[bookmark: _Toc451855818]表及圖的標註法
Tables and figures should appear on the same or next page as the first reference to them in the text. Do not break them across pages unless necessary. In addition, use only horizontal lines to delimit tables. The numbering of tables and figures should restart every chapter, in which the numbering takes the form “chapternumber.tablenumber”, e.g. Table 3.1 shows a comparison of instruction with no instruction on students’ achievement, attitudes toward subject matter, and attitudes toward learning. Table in appendices will be numbered “appendixletter.tablenumber”, e.g. Table A.1, A.2, B1, C.1…C.16. 

[bookmark: _Ref357115261][bookmark: _Toc357437592]表3.1  Comparison of the Effects of Instruction on Students' Achievement and Attitudes
	Outcome Measures
	With Instruction
	Without Instruction

	Achievement
	75.23
	61.05

	Attitudes toward subject matter
	10.48
	8.83

	Attitudes toward learning
	9.14
	8.65



Figure 3.1 shows an illustration of the overlap between curriculum and instruction. The figure number and caption go at the bottom of the figure on one line (unless it is too long). Figure and the number are italicized, but the caption is not. Capitalize only the first word and proper names in the caption.
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[bookmark: _Ref357115324][bookmark: _Toc357437606]圖3.1  Diagrammatic illustration of the overlap between curriculum and instruction.
[bookmark: _Toc451855819]Generate the LIST OF TABLES and FIGURES by WORD
Before you can automatically generate the LIST OF TABLES and FIGURES, you have to create captions so that WORD will know how many tables and figures you have. 中文請參考 Microsoft Word 的說明 (按F1)，搜尋［插入標號］及［交互參照］。
[bookmark: _Toc451855820]Use captions
You can add a caption to any picture, table, or equation in your document. You can also have Word automatically insert captions for some items. In addition, you can change the numbering format or change the label title.
Add a caption
Every caption is composed of a label and a number. You can add new labels and change the numbering format. Captions for each kind of object can be numbered sequentially. For example, you can have Figure 1, Table 1, Table 2, Table 3, Figure 2, Table 4, and so on. To do so, in your document, select the item that you want to add a caption to. On the Insert menu, click Caption. Select the options that you want such as Table or Figure.
[bookmark: _Toc451855821]Cross reference
A cross-reference refers to an item that appears in another location in a document. For example, you can mention "Figure 1" in your document and refer the reader to the figure's location elsewhere in the document. By default, Word inserts a cross-reference as a hyperlink that you can click to be taken directly to the cross-referenced item. You can create cross-references to items such as headings, footnotes, bookmarks, captions, and numbered paragraphs. If you add or remove content that causes the referenced item to move, you can update the cross-reference.
Create a cross-reference
You can insert cross references to any existing numbered items, headings, bookmarks, footnotes, endnotes, equations, figures, or tables in your document.
1. On the View menu, click Print Layout.
2. Position the cursor where you want the cross-reference to appear. For example, if you introduce your cross-reference with the words For more information, see, add a space after the word see, and then position the cursor after the space.
3. On the Insert menu, click Cross-reference.
4. On the Reference type pop-up menu, click the kind of item you want to refer to.
5. On the Insert reference to pop-up menu, click the description that you want to appear in the document. For example, if you create a cross-reference for a table, selecting Above/below inserts the word "above" if the table is located above the cross-reference.
6. In the For which caption box, click the specific item you want the cross-reference to refer to.
7. Click Insert.
Update a cross-reference from one page to another
Use this procedure if you move the item that you're cross-referencing from one page to another. For example, if you have a cross reference to a table and then move the table to another page, you must update the cross reference. On the View menu, click Print Layout, then do one of the following as listed in Table 3.2:

[bookmark: _Ref231352503][bookmark: _Toc357437593][bookmark: _Ref231352497]表3.2  How to update a cross-reference
	To
	Do this

	Update a specific cross-reference
	Point to the cross-reference, press CONTROL and click the cross-reference that you want to update, and then click Update Field.

	Update all cross-references in the document
	Select the whole document, press CONTROL and anywhere on the document, and then click Update Field.
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[bookmark: _Toc451855823]DESCRIPTION OF DEFAULT SUBHEADING SCHEME
The default format for chapter-level headings is bold, all upper case, and centered.  Otherwise the font is the same font family and the same size or no more than 2 font points larger (e.g. 14 points vs. 12).
Auto numbered list in Appendix will make styling menu too complicate to understand intuitively. Thus, I would suggest you to apply Headings 1 (標題1) to the first level subheadings here and then turn the numbering function off by clicking the “numbered list” icon in “Home” tab. 
[bookmark: _Toc98324478][bookmark: _Toc451855824]A.1  First-Level Subheading
The default format for first-level subheadings is centered, bold, and upper and lower case (UC/LC). Capitalize words as you usually would in a title. The wording and capitalization of all subheadings should exactly match the corresponding entry on the 'contents' page. A blank line above the subheading has already been built into this template so it is not necessary to leave another blank line before headings so long as you are using the proscribed heading and subheading styles.  Styles were discussed in Chapter 1 of this document.
[bookmark: _Toc451855825]A.1.1  Second-Level Subheadings
Second-level headings are justified left. The second-level subheading will also be UC/LC and bold.  That is the style built into this WORD document. The font size should be the same size as the text font. Since a blank line above each subheading was built into this template, it is not necessary to leave another blank line before headings so long as you are use the proscribed subheading style.
A.1.1.1 Third-Level Subheadings
Third-level subheadings are plain UC/LC text and underlined. Capitalize as with the other subheadings. 
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6 



Instruction 



 Jones and Smith (2005) refer to instruction as “the activities of educating or 



instructing or teaching” (p. 15). Lorem ipsum dolor sit amet, consectetur adipisicing elit, 



sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim 



veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo 



consequat. Table 1 shows a comparison of instruction with no instruction on students’ 



achievement, attitudes toward subject matter, and attitudes toward learning. 



 



Table 1 



Comparison of the Effects of Instruction on Students’ Achievement and Attitudes 



Outcome Measures With Instruction Without Instruction 



Achievement  75.23 61.05 



Attitudes toward subject matter 10.48 8.83 



Attitudes toward learning 9.14 8.65 



This is an alternate way to cite a page 
number when quoting in APA format. 



Except for certain exceptions (e.g., p and r 
values), report data to only 2 decimal places. 



Tables and figures should 
appear on the same or next 
page as the first reference 
to them in the text. Do not 
break them across pages 
unless necessary. 



In APA, the 
table number 
goes on one 
line. The 
italicized title 
appears on the 
next line. 
Capitalize each 
major word in 
the table title. 



Use only 
horizontal lines 
to delimit 
tables. 



 



 Figure 1 shows an illustration of the overlap between curriculum and instruction. 



Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor 



incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud 



exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. 



 



 



Curriculum Instruction 



In APA, the figure number and 
caption go at the bottom of the 
figure on one line (unless it is 
too long). Figure and the 
number are italicized, but the 
caption is not. Capitalize only 
the first word and proper names 
in the caption. 



 



 



 



 



 



 



 



Figure 1. Diagrammatic illustration of the overlap between curriculum and instruction. 










6  Instru ction    J o n e s   a nd Smith (2005) refer to instruction as “the activities of  educating  or  instru cting  o r   teaching” (p. 15). Lorem ipsum dolor sit amet, consectetur  adipis icing  e lit,  s e d  d o  e i u s m o d tempor incididunt ut labore et dolore magna aliqua. Ut  e n i m  a d  m i n i m   v e n i a m ,  q u i s  n ostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo  c o n s e q u a t .  T a b le 1 shows a comparison of instruction with no instruction  on  students’  a c h i e v e m e n t ,  a ttitudes toward subject matter, and attitudes toward learning.    T a b l e  1   Comparison of the Effects of Instruction on Students’ Achievement and  A t t i t u d e s   O u t c o m e  M e a s ures  With Instruction  Wi t h o u t  I n s t r u c t i o n   A c h i e v e m e n t    75.23  61.05  Attitud e s  to ward subject matter  10.48  8.83  A t t i t u d e s  t o w a rd learning  9.14  8.65  This is an alternate way to cite a page  number when quoting in APA format.  Except for certain exceptions (e.g., p and r  values), report data to only 2 decimal places.  Tables  and  figur e s  should  appear on  the sa me or ne xt  page as the first  reference  to them in the te xt. Do not  break  them  acro ss  pages  unless  necessar y .  In APA, the  table number  goes on one  line. The  italic ized  title  appears on th e  next line.  Capitalize  each  maj o r  w o rd  i n   the  table  title.  Use onl y   horizontal  lines  to  delimit  tables.     Fi g u r e   1 shows an illustration of the overlap between curriculum  a n d  i n s t r u c t i o n .   Lorem   ipsum  dolor sit amet, consectetur adipisicing elit, sed do eiusmod  tem por  incididunt  ut  labore et dolore magna aliqua. Ut enim ad minim veniam ,  q u i s  n o s t r u d   exercitation  ullamco laboris nisi ut aliquip ex ea commodo consequat.   
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Instruction 

In APA, the figure number a nd 

caption go at the  bottom of the 

figure  on  one  line   (unless  it  is 

too long). Figu re  and the 

number a r e italicized, but the 

caption  is  not.  Capitalize  only  

the first word a nd  proper  names 

in  the  caption. 

 

 

 

 

 

 

 

F i g u r e  1

. Diagrammatic illustration of the overlap between curriculum  and instru ction. 
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